
B2
Using Spry Widgets

One foundation of “Web 2.0” is widespread 
user interactivity enabled by extensive use 
of CSS and JavaScript. This allows applica-
tions that run inside a Web browser to offer 
the kind of responsiveness that was once 
reserved for native applications.

In Dreamweaver CS3, Adobe added a 
library of widgets that enable Web builders 
to make their sites look like cutting-edge 
destinations. This library—also referred 
to as a framework—is named Spry. Spry 
is a collection of HTML, CSS, JavaScript, 
and graphics, the relevant pieces of which 
are automatically added to your site when 
you add any of the Spry elements. No, you 
don’t need to know anything about CSS or 
JavaScript to use Spry.

In Dreamweaver CS5, Adobe expanded 
the program’s ability to use other popular 
frameworks (such as jQuery), which are 
covered in Chapter 14. In this chapter, we’ll 
focus on using the Spry elements that 
come with Dreamweaver.
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What Is Spry?
To use Spry’s full functionality, it helps to 
know a little bit more about what Spry is 
and how it works behind the scenes.

A (brief) history of frameworks
When people first started adding JavaScript 
to pages, they quickly realized that a lot of 
the work they were doing was the same 
stuff, over and over and over again. Just 
about every JavaScripter has their collec-
tion of code snippets that they’ve already 
debugged and now reuse regularly.

In recent years, it’s become common to let 
JavaScript handle more and more of the 
user interface (UI) duties. This means that 
Web sites have become smarter and more 
flexible, but it’s also been a lot more work 
for people who write code. Programmers 
tend to hate writing new code when they 
know someone else has already solved that 
particular problem. Instead, they go looking 
for free code offered by others, and in return 
offer their own solutions. The result is shared 
libraries of code that can handle most of the 
usual user interface requirements.

However, programmers also tend to have 
definite (and idiosyncratic) opinions about 
the “right” way to write code, and the result 
of that has been the creation of many dif-
ferent frameworks. If you’ve ever heard 
of libraries such as Dojo, YUI, jQuery, or 
Prototype, they’re all more or less the same 
thing, built by developers who thought that 
their way of doing things was better than 
what already existed.

Dynamic Data
Working with XML data is beyond the 
scope of this book, but that doesn’t 
mean that you can’t check out Spry 
data sets. Take a look at the examples 
at Adobe’s online Spry site (labs.
adobe.com/technologies/spry/); 
they should give you some good ideas 
of what’s possible.
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Spry is Adobe’s answer to this same chal-
lenge, geared to work with Dreamweaver 
and to stand on its own; in fact, you can 
download Spry from the Adobe website and 
use it as you would any other JavaScript 
framework, even if you don’t use Dream-
weaver. It’s not an application; instead, it’s a 
collection of code snippets (both CSS and 
JavaScript) that when added to your pages 
creates some standard effects.

What’s in Spry
Spry contains three types of components:

n	 Widgets: These elements let you create 
a more interactive Web site. There are 
two main types of widgets: UI widgets 
(such as the accordion, menu bar, and 
collapsible panel) and form validation 
(such as text fields and text areas).

n	 Effects: Unlike widgets, effects don’t 
so much interact with the user as just 
look good on their own. You can use 
effects to visually highlight transitions or 
to emphasize elements on your page. 
Some examples of effects are highlight, 
shrink, and squish.

n	 XML data sets: If you want data on your 
page that’s read from an external file, 
or you want users to be able to sort 
displayed information without hav-
ing to reload the page, or you want to 
show some detailed information when 
the user selects various options, then 
you’re looking at using Spry data sets.

This Looks Familiar…
If you’ve already read Chapter 14, you’ve 
probably noticed that the first couple of 
sections of this chapter are substantially 
identical to Chapter 14. For this CS6 revi-
sion, we needed to move most of the dis-
cussion of Spry out of the paper edition 
of the book to save space. Because Spry 
is moribund in Dreamweaver compared 
to jQuery, we chose to include more 
jQuery and less Spry in the main part of 
the book. But Spry hasn’t been entirely 
moved out of Dreamweaver, so we 
wanted to give readers of the paper edi-
tion a grounding in Spry—we hoped you 
would read this chapter if you wanted 
to know more. If you’re reading this, our 
strategy succeeded!
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Adding Spry Elements
By now, you’ve surely noticed the Spry cat-
egory A in the Insert panel. It’s just one of 
the many places where you can find Spry 
elements to add to your page.

To add a Spry element:
For widgets and data objects: With the 
Spry category showing in the Insert panel, 
choose where on your page you want to 
add the element, and then click the desired 
Spry button.

or

For widgets and data objects: Choose 
Insert > Spry from the menu bar, and then 
choose which Spry element you want to 
add from the submenu B.

or

For form validation widgets: Choose 
Insert > Form from the menu bar, and then 
choose which Spry widget you want to add 
from the submenu B.

or

For UI widgets: Choose Insert > Layout 
Objects from the menu bar, and then 
choose which Spry widget you want to add 
from the submenu B.

or

For effects: Select the element on the 
page you want the effect to affect, click the 
plus button on the Behaviors tab of the Tag 
inspector, and choose an action from the 
Effects submenu C.

  If you’ve added a widget, you’ll see the 
object on the page outlined with a bright blue 
border and the name of the widget. If you’ve 
added an effect, you’ll see it listed in the 
Behaviors panel tab of the Tag inspector.

A Spry widgets are found in the 
Spry category of the Insert panel.

  Believe it or not, these aren’t all the 
places where you can find options to add Spry 
elements in Dreamweaver.
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C Spry effects are considered behaviors, so they’re 
found in the Behaviors tab of the Tag inspector.

B Spry commands can be 
found in several locations 
in the Insert menu, as 
shown in this composite 
illustration.
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Using the Menu 
Bar Widget
One of the most common user interface 
items you’re likely to add to a site is the 
common menu bar. As mentioned in Chap-
ter 13, you can build complex menu bars 
in Fireworks—but what if you don’t have 
Fireworks, or its menus aren’t quite what 
you want? Spry menu bars are simple, flex-
ible, and powerful.

To add a menu bar widget:
1.	 Decide where you want the menu bar 

on your page, and click the Spry Menu 
Bar button in the Spry category of the 
Insert panel. The Spry Menu Bar dialog 
appears A.

2.	 Decide if you want a horizontal menu 
bar (a pull-down, where the main menu 
options go across and submenu options 
go down) or a vertical menu bar (a 
flyout, where the main menu options go 
down and submenu options go across). 
Click OK to accept.

3.	 The Spry menu bar appears on your 
page with default data displayed in the 
Property inspector B.

4.	 To change the names of menu items, 
click any item name in the first col-
umn of the Property inspector C and 

A The Spry menu bar can be horizontal or 
vertical.

B The brand-new Spry menu bar on our page 
starts off with some default values.

C After you’ve created the menu bar, you’ll set its values using the Property inspector.
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change the Text field on the right. Items 
in the second and third columns are 
submenus of the selected item in the 
previous column. To delete an item, 
select it and click the minus button at 
the top of the column. To add items, 
click the plus button at the top of the 
column and then change the name from 
the automatically named default. And 
to change the order, select an item and 
then click the up or down arrow at the 
top of the column.

5.	 Turn menu options into links by select-
ing the option and changing the Link 
field to the URL of the desired page D.

continues on next page

D Set the link for each menu bar item in the Property inspector.
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6.	 Click the Turn Styles Off button in the 
lower left of the Property inspector to see 
how the menu bar appears when CSS 
isn’t available E. Click the Turn Styles On 
button to make the styles reappear.

7.	 When you first save the page, or when 
you view the page in a browser, you’ll 
see the Copy Dependent Files dia-
log F. This lets you know that the 
required Spry files are being added. 
They’ll all be in a directory named Spry-
Assets at the root of your site, and you’ll 
need to upload that directory and the 
files it contains to your server so your 
site works correctly.

8.	 When you view your site in a 
browser G, you’ll see your new flyout 
(or pull-down) menu.

However, what you see is the menu 
in Dreamweaver’s default menu style. 
If that isn’t quite what you want, you’ll 
need to edit the widget’s styles.

E It’s a good idea to always check to 
see how your Spry elements appear 
without styling.

G And here’s our Web page with its new flyout 
menu.

F Every Spry command has one or more 
associated JavaScript, CSS, or graphics files. 
Dreamweaver warns you that it’s adding them to 
your site.
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To edit a menu bar widget:
1.	 This page uses an attached style sheet 

(hiking.css) that defines the desired 
appearance of its elements. To use the 
styles you’ve defined in the style sheet 
for menus, you first need to change 
the menu bar’s id from MenuBar1 to 
navlist, which you do by changing its 
name in the Property inspector H.

continues on next page

H You can modify the way the menu looks by changing the styles, as seen in the CSS Styles panel. 
We’ve begun the process by disabling some of the selected properties.



B2-10  Bonus Chapter B2

2.	 SpryMenuBarVertical.css contains the 
CSS for the Spry menu bar. You proba-
bly don’t want all the default Spry styles, 
so you need to figure out which rules 
affect the menu. Once that’s done, you 
can either add rules to hiking.css to 
override them, or delete/disable them 
in SpryMenuBarVertical.css. The 
easiest way to see which rules affect 
the menu is with the Code Navigator 
(see Chapter 7 for more about using the 
Code Navigator).

3.	 And finally, when you view the page 
in the browser, you see the new flyout 
menu just the way you’d expect it to 
appear I.

  The Turn Styles Off button on the 
Property inspector is also useful to verify that 
you’ve set up all your menus and submenus 
correctly, because it causes them to display all 
at once on the page.

  Be sure to always test your pages in a 
browser, though you can also get a good idea 
of how the menu will look by clicking the Live 
View button on the Document toolbar.

  To delete the widget, make sure the 
entire menu bar is selected and then press 
Delete.

  When using any Spry widget, be careful 
to test your pages for accessibility for those 
users who don’t have JavaScript, those with 
older browsers, and those with disabilities. 
Your sites need to work for everyone, not just 
people with the latest and greatest browsers, 
and the current version of Spry doesn’t always 
create widgets that work when (for instance) a 
visitor to your site sees it on a mobile device.

  In D, you can add a tool tip to any link 
simply by typing text into the Title field.

I The new flyout menu looks even better when 
its design matches the rest of the site.
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Using the Accordion 
Widget
An accordion widget is a set of panels, 
where one (and only one) is displayed at 
a time. It’s a handy way to present sev-
eral discrete chunks of information in a 
limited space.

To add an accordion widget:
1.	 Decide where you want the accor-

dion on your page, and click the Spry 
Accordion button in the Spry category 
of the Insert panel. A Spry Accordion 
widget with defaults and the Accordion 
Property inspector display A.

2.	 To change the default labels and con-
tent panels, simply type over them in 
the Dreamweaver document. The first 
panel is always shown by default when 
the page first loads.

3.	 To delete panels, select the panel in the 
Property inspector and then click the 
minus button. To add panels, click the 
plus button. And to change the display 
order of the panels, select a panel and 
then click the up or down arrow.

4.	 To view a specific panel inside Dream-
weaver, hover over the label until you 
see the eye icon. Click the eye, and that 
panel displays B.

continues on next page

A The accordion widget might be a better match 
for the type of information that we’re trying to 
display, so we’ve added one here.

B The panels can be set to display or hide 
inside Dreamweaver.
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5.	 Here’s your new accordion as seen in a 
browser C. Simply click the label, and 
the currently open panel closes and the 
desired panel opens. By adjusting the 
CSS of the widget, you can increase or 
decrease the height of the accordion 
panels (see the tip below). If you don’t 
adjust the height of the panel to match 
your content, it automatically displays a 
scrollbar, as in C.

  To change the height of an accordion 
panel, we first needed to discover which CSS 
rule controlled the panel’s height. We clicked 
in the panel’s content and chose View > Code 
Navigator (see Chapter 7 for more on that 
feature). The Code Navigator window showed 
a rule named .AccordionPanelContent, 
which had a default height of 200 pixels. We 
clicked the rule in the Code Navigator window, 
which changed the document window to Split 
view, highlighting the rule in the Code pane. 
We then changed the value of the height 
attribute to 100 pixels and saved the file.

  When adding a widget to an existing 
page, be careful about moving text that’s 
already on the page into the widget. Wid-
gets can be fragile, and if you don’t drag and 
drop the text into exactly the right spot, you 
can end up with a mess. We’ve had better 
luck just deleting text and retyping it directly 
into widgets.

C And here’s the final accordion in the browser.
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Using the Collapsible 
Panel Widget
If the accordion widget is almost, but not 
quite, just what you want, then the collaps-
ible panel widget is probably what you’re 
looking for. Where the accordion widget 
allows you to have one—and only one—
open panel, the collapsible panel widget 
lets you have as many or as few as you 
and your visitors want.

To add a collapsible panel widget:
1.	 Decide where you want the collapsible 

panel on your page, and click the Spry 
Collapsible Panel button in the Spry 
category of the Insert panel. A Spry Col-
lapsible Panel widget with defaults and 
the Collapsible panel Property inspec-
tor display. A shows a document with 
two collapsible panel widgets that have 
content in each panel.

2.	 You can set each panel to be open or 
closed when the page loads. Toggle the 
display by changing the Default state 
in the Property inspector from Open to 
Closed or vice versa.

3.	 Choose whether or not the panel con-
tents are viewable inside Dreamweaver 
by toggling the Display value in the 
Property inspector from Open to Closed 
and back again.

or

Hover over the label until you see the 
eye icon, as seen in A. If the panel is 
closed, the eye icon is open. Click it to 
open the panel B. If the panel is open, 
the eye icon is closed, and clicking it 
closes the panel.

continues on next page

A Multiple collapsible panels is another UI 
approach, allowing us to have multiple panels 
display at one time.

B Again, panels can be seen and 
hidden inside Dreamweaver without 
affecting how they will appear in the 
browser. When you hover over a panel, 
a tool tip with the panel’s CSS property 
information will also briefly appear, as 
shown here.
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4.	 Change the default labels and con-
tent panels by simply typing over their 
current values in the Dreamweaver 
document.

5.	 Finish up by checking the display 
in Dreamweaver’s Live view or a 
browser. C shows the panels in their 
collapsed state, and D shows them in 
their open state.

  The Property inspector also contains a 
check box to enable (or disable) animation. If 
it’s on, visitors to your site see a brief anima-
tion when they open and close panels. If you 
think that people might get impatient, turn off 
the animation.

C Here are the two panels— 
both closed—in the browser window.

D Click each label, 
and its panel slides 
open so you can see 
all the information 
at once.
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Validating Forms 
with Spry
The form in A should look familiar, 
because it’s the same form example used 
earlier in this book. But if you look at B, 
it’s actually a little different—you can see 
that Spry has added some smarts to it. The 
addition of the new error messages (which 
only appear on your site if the form is filled 
out incorrectly) tell people filling out the 
form more about what kind of data they 
need to enter where.

Dreamweaver has the ability to validate a 
group of radio buttons, validate password 
fields, and require the user to enter a pass-
word twice for verification.

To add Spry validation 
to a text field:
1.	 Select an existing text field and click 

the Spry Validation Text Field button in 
the Spry category of the Insert panel. 
The usual blue box appears around the 
field, and the Spry TextField Property 
inspector appears C.

continues on next page

A This contact form doesn’t look particularly 
intelligent.

B But once visitors see the error messages, they 
have a better idea of what’s required.

C Text fields can be set to require some value before the form can be submitted.
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2.	 Using the Property inspector, you can 
make your text fields require a wide 
range of input types. C shows a text field 
that requires that something (anything) 
be in the Last Name field. That’s done by 
selecting the Required check box, and 
setting the Min chars field to one.

D shows the email address field, 
which is a little more complex. Here, 
the Type drop-down menu is set to 
Email Address, which rejects the user’s 
entry unless it matches the format of an 
email address.

The Last Name field is set to show 
the field required error, and the Email 
field is set to show the invalid format 
error. These are done via the Preview 
states drop-down menu in the Property 
inspector, which lets you see how each 
possible error message displays inside 
Dreamweaver. And along with the error 
messages, the entry field has a pink 
background, showing that the current 
entry is insufficient.

D Text fields can also be set to require very particular data, such as in this Email field, before submission 
is allowed.
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To add Spry validation 
to a select field:
Select an existing pop-up menu and click 
the Spry Validation Select button in the 
Spry category of the Insert panel. Once 
again, you’ll see the blue box appear with 
its associated Property inspector E.

A pop-up menu can be set to have a 
required value or to only allow certain 
selections. You can also preview the vari-
ous error messages inside Dreamweaver.

E This pop-up menu is now set to require visitors to make a choice.
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To add Spry validation 
to check boxes:
1.	 Select where you want your new check 

boxes to be placed, and click the Spry 
Validation Checkbox button in the  
Spry category of the Insert panel.  
The Input Tag Accessibility Attributes 
dialog appears, which was covered 
in Chapter 11. Enter the appropriate 
data and click OK. Your new check box 
appears in its standard blue box, and 
the Property inspector displays the Spry 
Checkbox F.

2.	 If you want the validation to apply to 
a group of check boxes instead of a 
single check box, add them inside the 
Spry region at this point or drag existing 
check boxes into the region.

3.	 The Property inspector allows you to 
require a single check box to be set, or 
to require a certain minimum number of 
check boxes to be set. In this example, 
we want visitors to click at least one 
check box of the five, so the minimum is 
set to one and the maximum to five. F 
shows the error message that displays 
when they submit the page without 
picking any of the check boxes.

F Check boxes can be validated individually or in groups.
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To add Spry validation 
to radio buttons:
1.	 Select where you want your new radio 

buttons to be placed, and click the Spry 
Validation Radio Group button in the 
Spry category of the Insert panel.

The Spry Validation Radio Group dialog 
appears G. This is similar to the Radio 
Group dialog discussed in Chapter 11.

2.	 Fill out the dialog, and then click OK.

The radio buttons appear on the page, 
and you see the Spry Radio Group in 
the Property inspector H.

  A radio button group must have one of 
its choices selected, but Dreamweaver doesn’t 
know which button you want selected, so you 
must do it yourself. Click the button that you 
want to use as the default choice, and the 
Property inspector will change to show that 
button’s properties. In the Initial state section, 
choose Checked.

G Begin adding your validated radio button group 
by entering the button values.

H By default, a radio button group is set to have a required value.
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To add Spry validation 
to a text area:
1.	 Select an existing text area field, and 

click the Spry Validation Textarea but-
ton in the Spry category of the Insert 
panel. You’ll see the usual blue box and 
Property inspector I.

2.	 In the Property inspector, you can set 
it so the text area is required and set 
it to have a minimum or maximum 
length. Additionally, you can choose to 
display a counter of characters filled in 
or characters remaining, so that users 
know how close they are to the limit. 
And finally, the Hint field puts optional 
text into the field when the form loads, 
telling users what type of information 
you’re requiring them to enter.

3.	 J shows how the form appears in the 
browser when the page first loads. K 
is an attempt to validate our bad input, 
showing the two error messages 
we’ve received.

  Any field can be set to validate on blur, 
change, or submit, where the default is sub-
mit. Blur refers to when users exit the field, 
whether or not they’ve actually changed its 
value.

  The text area Hint text automatically 
clears itself when the user enters the field. 
Hint text also doesn’t count as characters 
toward the entry requirements or limits.

I Text area boxes can require that at least a 
certain amount of data be entered and give a hint 
to the visitor as to what’s necessary.

J The form looks straightforward when it’s first 
loaded in the browser.

K But this form won’t let us get away with trying 
to submit it without the required fields.
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To add Spry validation 
to a password field:
1.	 Click to place the insertion point where 

you want to add your password field, 
and click the Spry Validation Password 
button in the Spry category of the Insert 
panel.

The Input Tag Accessibility Attributes 
dialog appears L.

2.	 Enter the appropriate data and click OK.

The password field appears in the 
document, and the Property inspector 
changes to reflect the Spry Password 
choices M.

3.	 Set the requirements for the password 
in the Property inspector. You can spec-
ify the minimum and maximum number 
of characters, how many letters and 
numbers must appear in the password, 
whether or not letters must be upper-
case, and whether special characters 
are allowed or required.

L You need to give the password field an ID and 
a label.

M Set the password’s requirements in the Property inspector.
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To add a Spry confirmation field:
1.	 Confirmation fields require the user 

to reenter the same value as another 
field in the form. They’re usually used 
with password fields. Begin by placing 
the insertion point where you want to 
add your confirmation field, and click 
the Spry Validation Confirm button in 
the Spry category of the Insert panel. 
The Input Tag Accessibility Attributes 
dialog appears.

2.	 Enter the appropriate data and click OK.

The confirmation field appears in the 
document, and the Property inspector 
changes to reflect the Spry Confirm 
choices N.

3.	 In the Validate against pop-up menu, 
choose the field you want to validate 
against. If there is only one field and 
one form on the page, it will appear in 
the pop-up menu automatically.

N The confirming password field is set to validate against the original password field.
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Adding Spry Tooltips
Dreamweaver allows you to add a Spry 
Tooltip, which is a short bit of text that 
appears when you hover over an area on 
your page. Spry Tooltips have two parts: 
the trigger, which is the part of your page 
that serves as the hotspot for the user’s 
cursor, and the content, which is the 
Tooltip’s text.

To add a Spry Tooltip:
1.	 Click to place the insertion point where 

you want to add the Tooltip, and click 
the Spry Tooltip button in the Spry cat-
egory of the Insert panel.

Default trigger text and a field for the 
content appear in the document A.

or

Select an element on the page and 
click the Spry Tooltip button in the Spry 
category of the Insert panel.

The field for the Tooltip’s content 
appears in the document. When you 
first select an existing element, Dream-
weaver assumes that you want the ele-
ment to be the Tooltip’s trigger.

The Property inspector changes to 
reflect the Spry Tooltip choices.

continues on next page

A If you don’t select an element before adding a Spry Tooltip widget, 
you get boilerplate text for the Tooltip’s trigger and content.

The Future of Spry
As mentioned at the beginning of this 
chapter, it’s possible to get Spry as a free 
download and use it with your sites even 
if you don’t have Dreamweaver. Because 
this is a book on Dreamweaver, we won’t 
get into how Spry is used outside of 
Dreamweaver.

Dreamweaver CS6 is shipping with Spry 
1.6.1 as this book goes to press. However, 
that was also the version that shipped 
with Dreamweaver CS4, so it’s clear that 
Spry development has stalled. By add-
ing the ability to use widgets from other 
JavaScript frameworks, notably jQuery, 
in Dreamweaver CS5, Adobe is signaling 
that Spry will be maintained for now but 
not expanded.

You can check to see if there’s a 
newer version of Spry by going to the 
Adobe Labs page at labs.adobe.com/
technologies/spry/. There, you’ll find 
Spry demos, forums, and documenta-
tion of what’s possible to create with 
Spry. The Spry team even has a blog, 
which you can find at blogs.adobe.com/
spryteam/.

To get newer versions of Spry (if or when 
they’re available), use the Extension 
Manager. The process is described in 
Appendix B, “Customizing and Extending 
Dreamweaver.”
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2.	 If you did not select an element before 
you inserted the Tooltip, type over the 
default trigger text with the text you 
want to appear on the page. If you did 
select an element, skip to step 3.

3.	 Type over the default text in the Tooltip 
content field, replacing it with your 
desired text.

4.	 In the Property inspector, choose from 
the Trigger pop-up menu B.

5.	 (Optional) Choose how the Tooltip will 
appear to the user in the browser by 
setting its horizontal or vertical offset 
and whether there will be a delay or a 
visual effect as the Tooltip appears or 
disappears C.

B You need to set the Tooltip’s trigger and visual effects (if you want them) in the Property inspector.

C The Tooltip appeared when I hovered the  
cursor over the password field.
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Adding Spry Effects
You can use Spry to add visual effects to 
elements on your page with behaviors. 
As shown in C in “Adding Spry Ele-
ments,” Spry effects are in the Behaviors 
tab of the Tag inspector. There are seven 
Spry effects: Appear/Fade, Blind, Grow/
Shrink, Highlight, Shake, Slide, and Squish. 
See them in action at labs.adobe.com/
technologies/spry/demos/effects/.

If you need a refresher on behaviors, please 
review Chapter 13. Remember to be careful 
setting which events trigger behaviors; if 
you want an effect to take place when an 
element is clicked, it should happen on the 
onClick (for instance), not onMouseOut.

Appear/Fade
The Appear/Fade effect makes an element 
appear or fade away. A shows the dialog, 
which allows you to set the element, the 
duration, the effect (appear or fade), the 
start and end percentages, and whether 
you want the effect to be reversible.

Blind
The Blind up/down effect works like a 
window blind that hides or shows the ele-
ment. The dialog B lets you choose the 
element, the duration, the effect (blind up or 
down), the start and end values, and whether 
you want the effect to be reversible.

Grow/Shrink
The Grow/Shrink effect makes the ele-
ment larger or smaller. Use the dialog C 
to set the element, the duration, the effect 
(grow or shrink), the start and end values, 
whether you want the element to move 
toward the center of the page or its upper-
left corner, and whether you want the 
effect to be reversible.

A The Appear/Fade dialog lets you control 
that effect.

B The Blind dialog might sound scary, but in 
reality it makes an element on your page look like 
it’s a window shade.

C The Grow/Shrink dialog allows you to make 
objects on your page get larger or smaller.
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Highlight
The Highlight effect changes the back-
ground color of the element, causing it to 
stand out on the page. The Highlight dialog 
D is where you set the element, the dura-
tion, the start and end colors of the high-
light, the color you want displayed after the 
effect has completed running, and whether 
you want the effect to be reversible.

Shake
The Shake effect does just what it sounds 
like—it makes the selected element 
shimmy in place. As E shows, all you can 
set is the target element.

Slide
The Slide up/down effect moves the 
selected element up or down on the page. 
The Slide dialog allows you to set the tar-
get element, the duration, the effect (slide 
up or down), the beginning and ending 
values, and whether you want the effect to 
be reversible F.

Squish
The Squish effect makes the selected ele-
ment disappear into the upper-left corner 
of the page. The element is set in the 
Squish dialog, as shown in G.

Not all effects can be applied to all elements. 
Play with them to see which behaviors work 
with particular objects on your page.

  You can combine effects as well; all you 
have to do is keep adding behaviors to a given 
element. Be careful, though, to avoid getting 
too tacky!

D The Highlight effect changes the background 
color for the target element.

E The Shake effect does just what it sounds like.

F Make an element slide up or down your page 
with the Slide effect.

G The Squish dialog lets you make elements on 
your page appear smooshed.




